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ArcGIS 3D Analyst Tutorial
IN THIS TUTORIAL
• Copying the tutorial data

The best way to learn ESRI® ArcGIS® 3D Analyst™ is to use it. In the
exercises in this tutorial, you will:
• Use ArcCatalog™ to find and preview 3D data.

• Exercise 1: Draping an image over
a terrain surface
• Exercise 2: Visualizing
contamination in an aquifer
• Exercise 3: Visualizing soil
contamination and thyroid
cancer rates
• Exercise 4: Building a TIN to
represent terrain
• Exercise 5: Working with
animations
• Exercise 6: ArcGlobe basics

• Add data to ArcScene™.
• Set 3D properties for viewing data.
• Create new 3D feature data from 2D features and surfaces.
• Create new raster surface data from point data.
• Build a TIN surface from existing feature data.
• Make animations.
• Learn how to use ArcGlobe™ and manage its data content.
In order to use this tutorial, you need to have the 3D Analyst extension and
ArcGIS installed and have the tutorial data installed on a local or shared
network drive on your system. Ask your system administrator for the
correct path to the tutorial data if you do not find it at the default
installation path specified in the tutorial.

• Exercise 7: ArcGlobe layer
classification
• Exercise 8: Creating and using a
terrain dataset
• Exercise 9: Creating a realistic 3D
view
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Copying the tutorial data
First you will copy the tutorial data to a local drive. You
will use ArcCatalog to browse to and copy the data.

3. Right-click the 3DAnalyst folder and click Copy.

1. Click Start, point to Programs, point to ArcGIS, and
click ArcCatalog.

1
ArcCatalog lets you find and manage your data. The left
side of the ArcCatalog window is called the Catalog
tree; it gives you a bird’s-eye view of how your data is
organized and provides a hierarchical view of the
geographic data in your folders. The right side of the
Catalog window shows the contents of the selected
branch of the Catalog tree.

3

4. Right-click the local drive where you want to place the
tutorial data and click Paste.

4

2. Click in the Location combo box and type the path to
the \arcgis\ArcTutor folder on the drive where the
tutorial data is installed. Press Enter.

2
The ArcTutor folder is now the selected branch of the
Catalog tree. You can see its contents in the Contents
tab.

The folder is copied to your local drive. Now you’ll
make a folder connection to the 3DAnalyst folder in the
Catalog tree.

2
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5. Click the 3DAnalyst folder on your local drive and drag
it onto the top-level node, Catalog, of the Catalog tree.

5

There is now a folder connection in the Catalog for your
local copy of the tutorial data.
In the graphics illustrating this tutorial, the ArcCatalog
option to use a special folder icon for folders containing
GIS data is turned on. That is why the folder GISdata, in
the graphic above, looks different from the other folders.
You can turn this option on in ArcCatalog, in the Options
dialog box, on the General tab. ArcCatalog works faster
when this option is turned off, so it is off by default.

ARCGIS 3D ANALYST TUTORIAL

3Danalyst_tutorial_3.pmd

3

3

5/5/2008, 8:18 AM

Exercise 1: Draping an image over a terrain surface
Viewing a remotely sensed image draped over a terrain
surface can often lead to greater understanding of the
patterns in the image and how they relate to the shape of
the earth’s surface.
Imagine that you’re a geologist studying Death Valley,
California. You have collected a TIN that shows the terrain
and a satellite radar image that shows the roughness of the
land surface. The image is highly informative, but you can
add a dimension to your understanding by draping the
image over the terrain surface. Death Valley image data
was supplied courtesy of NASA/JPL/Caltech.

2. Check 3D Analyst.
3 Click Close.

2

Turning on the 3D Analyst extension
You’ll need to enable the 3D Analyst extension.

3

1. Click Tools and click Extensions.
Previewing 3D data in ArcCatalog

Before you drape the image, you’ll browse to the terrain
data and preview it in ArcCatalog.
1. Navigate to the 3DAnalyst folder connection in the
Catalog tree.

1

4
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2. Double-click 3DAnalyst.
3. Double-click Exercise1.

5. Click the Preview tab. You can preview your GIS data in
ArcCatalog. With 3D Analyst installed, you can also
preview some data in three dimensions.

2

6. Click the Preview drop-down arrow and click 3D View.

3
6

You see a folder called Data and a TIN layer called
Death Valley Terrain.

7. Right-click above the preview window and click 3D
View Tools.

A layer is a shortcut to geographic data. It also stores
information about how the geographic data should be
drawn on a map or in a 3D scene.

7

4. Click Death Valley Terrain.

4

5

6
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The preview becomes a 3D preview, and a new set of
tools appears on the 3D View Tools toolbar.
Navigate

The data rotates around its center. The Navigate tool
also allows you to zoom in and out and pan across the
data, depending on the mouse button that you click
while dragging in the 3D preview.
9. Right-click the 3D preview and drag down.

Zoom In/Out

Pan

The Navigate tool is active when you first preview data
in 3D. You can see the names of tools by hovering the
pointer over the tool.

9

The Navigate tool allows you to rotate 3D data and
change the apparent viewer height by clicking and
dragging left and right and up and down, respectively, in
the 3D preview.
8. Click the 3D preview and drag to the right.

The pointer changes to the Zoom In/Out pointer, and the
view zooms in to the data.
10. Click the middle button—or both the right and left
buttons if you have a two-button mouse—and drag to
the right.

8
Q

6
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The pointer changes to the Pan pointer, and the view
pans across the data.

The view returns to the full extent of the data.

11. Click the Identify button and click on the TIN.

Identify

The Identify Results window shows you the elevation,
slope, and aspect of the surface at the point you clicked.
12. Close the Identify Results window.

E

Now you’ve examined the surface data and begun to learn
how to navigate in 3D. The next step is to start ArcScene
and add your radar image to a new scene.
Starting ArcScene and adding data
ArcScene is the 3D viewer for 3D Analyst. Although you
can preview 3D data in ArcCatalog, ArcScene allows you
to build up complex scenes with multiple sources of data.

13. Click the Full Extent button.

R

1. Click the ArcScene button on the 3D View Tools
toolbar.
ArcScene

ARCGIS 3D ANALYST TUTORIAL
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ArcScene starts. Note that many of the tools on the
ArcScene Standard toolbar are the same as the 3D
navigation tools that you see in ArcCatalog.

3. Click the Add Data button on the ArcScene Standard
toolbar.

3

2. Click the Death Valley Terrain layer in the Catalog tree
and drag it onto the right-hand side of the ArcScene
window, then release the mouse button.

4. Navigate to the Data folder for Exercise1.

2
4
The TIN is drawn in the new scene.

8
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5. Click dvim3.TIF.

7. Uncheck the Death Valley Terrain layer.

6. Click Add.

5

6
The image is added to the scene.

7
Now you can see the whole image. The black areas are
parts of the image that contain no data and are a result
of previous processing to fit the image to the terrain.
You have added the image to the scene. Now you will
change the properties of the image layer so that the image
will be draped over the terrain surface.
Draping the image

The image is drawn on a plane, with a base elevation
value of zero. You can see it above the Death Valley
terrain surface where the terrain is below 0 meters
elevation (sea level); it is hidden by the terrain surface
everywhere else.

While the surface texture information shown in the image
is a great source of information about the terrain, some
relationships between the surface texture and the shape of
the terrain will be apparent when you drape the image over
the terrain surface. In ArcScene, you can drape a layer—
containing a grid, image, or 2D features—over a surface (a
grid or TIN) by assigning the base heights of the layer from
the surface.

ARCGIS 3D ANALYST TUTORIAL

3Danalyst_tutorial_3.pmd

9

9

5/5/2008, 8:18 AM

1. Right-click dvim3.TIF in the ArcScene table of contents
and click Properties.

3. Click the option to Obtain heights for layer from
surface.
Because the TIN is the only surface model in the scene,
it appears in the surface drop-down list.

1
The layer Properties dialog box appears. You can
change how a layer is drawn on a map or in a scene by
setting its properties.
4. Click OK.

2. Click the Base Heights tab.

The image is draped over the terrain surface.

2

Now you will be able to navigate around the image and see
the relationship between surface texture, as shown by the
image colors, and the shape of the terrain.

3

Exploring the image
You will use the navigation tools on the ArcScene Tools
toolbar to explore the draped image.
1. Click the Zoom in button.

1

4
10

3Danalyst_tutorial_3.pmd

ARCGIS 3D ANALYST TUTORIAL

10

5/5/2008, 8:18 AM

2. Click and drag a rectangle around the middle of the
image.

4. Click and hold the scene with the cursor, and slowly
drag up and to the left.

4

2

The scene zooms to the middle part of the image.
The scene rotates, and the view angle lowers, so it looks
as though you are looking down the valley, past the
higher land on the left side of the scene.
Elevated, rocky area

3. Click the Navigate button.

3

Alluvial fan
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The elevated land is visibly rougher terrain than the flat
valley bottom. The surface texture—and therefore the
color, in the radar image—of this rocky area is different
than the fine sediment of the floodplain—the yellow and
black region in the valley bottom. The rocky area is also
a different texture from the gently sloping alluvial fan
that runs past it, down onto the valley floor.
Draping the radar image over the terrain surface allows you
to see the relationship between the general shape of the
land surface and the texture of the rocks and sediment that
make up the surface.

The Scene Properties dialog box lets you set properties
that are shared by all of the layers in the scene. These
include the vertical exaggeration, the background (sky)
color, the coordinate system and extent of the data, and
the way that the scene is illuminated (the position of the
light source relative to the surface).
2. Click the General tab.
3. Type “2” in the Vertical Exaggeration combo box.

2

3

Exaggerating the terrain
The valley is a broad area, relative to the height of the
terrain, even though the mountains at the edge of the scene
are more than 2,000 meters above the valley floor. In order
to enhance the sense of depth in the scene, and to bring out
subtle features in the terrain, you will exaggerate the height
of the terrain.
1. Right-click Scene layers in the table of contents and
click Scene Properties.

4
4. Click OK.
The apparent height of the terrain is now doubled.

12
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You can now clearly see how the alluvial fan spreads
out onto the valley floor, between the larger rocky area
at the center of the scene and the smaller rocky area in
the foreground at the left side of the scene.

1. Click File and click Save As.

1

2. Navigate to the Exercise 1 folder.
3. Type “Deathvalley”.

2
You have added depth to the radar image, explored the
general relationship between the data in the image and the
terrain data, and enhanced the scene so that you can
perceive more subtle variations in the terrain.
Now that you’ve built the scene, you will save it so that
you can explore it later if you choose.

4

Saving the scene
Scenes, also called Scene Documents, are like maps. They
contain information about how the layers that are in the
scene should be rendered and where the data is located.

3
4. Click Save.
The scene will now be available for you to open later.
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Exercise 2: Visualizing contamination in an aquifer
Imagine that you work for a water district. The district is
aware of some areas where volatile organic compounds
(VOCs) have leaked over the years. Scientists from your
department have mapped some plumes of VOCs in the
aquifer, and you want to create a 3D scene to help officials
and the public visualize the extent of the problem.

3. Click Groundwater.sxd.

3

Some of the data for the scene has already been assembled
in the Groundwater scene. You will modify the scene to
better communicate the problem.

4

VOC data was supplied courtesy of the San Gabriel Basin
Water Quality Authority.
Opening the Groundwater scene document
This scene document contains a TIN that shows the shape
of the contaminant plume, a raster that shows the
concentration of the contaminant, and two shapefiles that
show the locations of parcels and wells. You will drape the
concentration raster over the plume TIN, extrude the
building features and change their color, and extrude the
well features so that the wells that are most endangered by
the contamination may be more easily recognized.
1. In ArcScene, click File, then click Open.

4. Click Open.
The Groundwater scene opens. You can see the four
layers in the table of contents.
Showing the volume and intensity of
contamination
You’ll drape the raster of VOC concentration over the TIN
of the contaminant plume surface to show the volume and
intensity of contamination in the aquifer.
1. Right-click congrd and click Properties.

1
1

2. Navigate to the Exercise2 folder.

14
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2. Click the Base Heights tab.

4. Click the Symbology tab.

3. Click the drop-down arrow and click plume to get the
heights from the plume TIN.

5. Click the Color Ramp drop-down arrow and click a red
color ramp for the raster.

2

4

3
5

6

Now you will change the symbology of the raster to
show the intensity of the contamination.
6. Click OK.

7. Uncheck plume in the table of contents.

7

Now it is possible to see the shape of the plume and its
intensity in 3D.
ARCGIS 3D ANALYST TUTORIAL
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Showing the relationship of the plume to wells

4. Click WELL_DPTH.

You can see that some of the wells are within the area of
the plume. However, it is difficult to see which wells are
most seriously affected because the contamination is more
widespread but less concentrated at greater depths.

5. Click OK.

4

You will extrude the well features based on their depth
attribute in order to see which wells intersect the plume.
1. Right-click wells and click Properties.

1
5
2. Click the Extrusion tab.
3. Click the Calculate Extrusion Expression button.
You will display the well points as vertical lines equal to
the depth of the well. This information is stored in the
WELL_DPTH field.

6. Click the drop-down arrow to apply the extrusion
expression by adding it to each feature’s base height.
The well depths are expressed as negative values, so
they’ll be extruded downward.

2
6
3
7
7. Click OK.

16
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You can see the places where the wells intersect, or are
close to, the plume. Now you will modify the scene to
show the priority of various facilities that have been
targeted for cleanup.
Showing the facilities with a high cleanup priority

6. Click OK.

4

Analysts in your department have ranked the facilities
according to the urgency of a cleanup at each location.
You’ll extrude the facilities into 3D columns and color
code them to emphasize those with a higher priority for
cleanup.

5

6

1. Right-click facility and click Properties.

The expression you created appears in the Extrusion
value or expression box.

2. Click the Extrusion tab.
3. Click the Calculate Extrusion Expression button.

2

3

4. Click PRIORITY1.
5. Type “* 100”.

ARCGIS 3D ANALYST TUTORIAL
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Now you’ll save your changes to the scene.

7. Click the Symbology tab.
8. Click Quantities.
9. Click the Value drop-down list and click PRIORITY1.

W

7

8

11. Click the Save button.

9

Q
10. Click OK.
The facilities are now extruded in proportion to their
priority score. The scene now shows the shape and
intensity of the contamination, the wells in relationship
to the plume, and the facilities that need to be cleaned
up in order to prevent further pollution of the
groundwater.

18
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Exercise 3: Visualizing soil contamination and thyroid cancer rates
In 1986, after the catastrophic accident at the Chernobyl
nuclear power plant in Ukraine, a large amount of
radioactive dust fell on Belarus. Since then, scientists have
studied the aftermath of the accident. One tool for
exploring the data is 3D visualization. In this exercise, you
will create two surfaces from point data collected in
Belarus. One set of points contains measurements of soil
CS137 concentrations. CS137 is one of several radioactive
isotopes released by the accident. The other set of points
shows the rates of thyroid cancer, aggregated by district,
with the sample point placed near the district centers.
The CS137 contamination and thyroid cancer data was
supplied courtesy of the International Sakharov
Environmental University.
Viewing the point data
First, you will open the Chernobyl scene and view the point
data.
1. In ArcScene, click File and click Open.

1

2. Navigate to Exercise3 and click Chernobyl.

2

3

3. Click Open.
The CS137 soil measurements are shown with small
point symbols, using a graduated color ramp to show the
intensity of the contamination. The districts’ thyroid
cancer rates are shown with larger symbols, using a
different color ramp.
Creating 3D point features
The soil CS137 samples are 2D points with some
attributes. One way to view 2D points in 3D is by setting
an extrusion expression, or a base height. You can also
incorporate a z-value into a feature’s geometry to allow it
to be directly viewed in 3D without the need to set a base
height from a surface or an attribute.
This exercise requires the 3D Analyst toolbar. You’ll need
to add it to ArcScene if not already present from the
previous exercise.

ARCGIS 3D ANALYST TUTORIAL
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1. Click View, point to Toolbars, and click 3D Analyst.

3. Click the Input Features drop-down list and click
Subsample_1994_CS137.
4. Click the Input Feature Attribute button, then click the
Input Feature Attribute drop-down list and click
CS137_CI_K.

1

5. Change the output feature name to CS137_3D.

3
The 3D Analyst toolbar in ArcScene contains several 3D
analysis and data conversion tools. The ArcMap 3D
Analyst toolbar contains the same tools, plus several
additional tools that you can use in ArcMap.

4
5

Now you will create 3D point features from the soil
CS137 points.
2. Click 3D Analyst, point to Convert, and click Features
to 3D.

6
6. Click OK.
The features are converted to 3D point features. However,
they still seem to be resting on a flat plane because the
CS137 concentration values range from 0 to 208.68, which
is small, relative to the horizontal extent of the data.

2

20
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Increasing the vertical exaggeration

4. Click OK.

You will exaggerate the scene to show the new points with
their height embedded in the feature geometry.

5. Click the Full Extent button.

1. Click View and click Scene Properties.

5
Now that you can see the new 3D points in the scene,
you can turn off the original CS137 sample point layer.
6. Uncheck the box in the table of contents beside
Subsample_1994_CS137 and click the minus sign
beside the box to hide the classification.

1
2. Click the General tab.

6

3. Click Calculate From Extent.

2
Extruding columns

3

Viewing points in 3D space is one way to investigate data.
Another way is to extrude points into columns. You will
extrude the thyroid cancer points into columns to compare
them to the contamination data.
1. Right-click ThyroidCancerRates and click Properties.

1

4
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7. Click OK on the Layer Properties dialog box.

2. Click the Extrusion tab.
3. Click the Calculate Extrusion Expression button.

2

3

4. Click INCID1000 (the rate of cases per 1,000 persons).
Because the z-values of the phenomena that you are
comparing have different ranges, you will multiply the
cancer rate by 100 to bring the values into a range
similar to that of the CS137 measurements.
5. Type “* 100”.
6. Click OK on the Expression Builder dialog box.

4

Now the district centroid points are shown with columns
proportionate to the thyroid cancer rates. If you navigate
the scene you will see that the areas with the highest
contamination levels also tend to have high thyroid
cancer rates, although there are areas with lower CS137
contamination levels that also have high cancer rates.
Creating a surface from point sample data
You know what the soil concentrations of CS137 are at the
sample point locations, but you do not know what they are
at the locations between sample points. One way to derive
the information for locations between sample points is to
interpolate a raster surface from the point data. There are
many ways to interpolate such surfaces, which result in
different models of varying accuracy. In this exercise you
will interpolate a surface from the samples using the
Inverse Distance Weighted (IDW) interpolation technique.
IDW interpolation calculates a value for each cell in the
output raster from the values of the data points, with closer
points given more influence and distant points less
influence.
1. Click 3D Analyst, point to Interpolate to Raster, and
click Inverse Distance Weighted.

5

1

6
22
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2. Click the Input points drop-down list and click
Subsample_1994_CS137.
3. Click the Z value field drop-down list and click
CS137_CI_K.
4. Click inside the Output cell size box and increase the
value to 5000.

7
2
3

6
7. Click Save.
8. Click OK. ArcScene interpolates the surface and adds it
to the scene.

4
5
5. Click the Browse button to set the output raster location.
6. Navigate to the Exercise3 folder and type
“CS137_IDW” in the Name field.

8
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Viewing the interpolated surface

4. Click the Base Heights tab.

Now that the surface has been added to the scene, you can
see that there are two areas with very high concentrations
of CS137. You will view the surface in perspective, with a
new color ramp, to better see its shape.

5. Click Obtain heights for layer from surface.
6. Click OK.

4

1. Right-click CS137_IDW and click Properties.

5

1
If prompted to create a unique values histogram for the
new raster data, click Yes.

6
7. Uncheck CS137_3D in the table of contents.
2. Click the Symbology tab and select Stretched from the
Show category.
3. Click the Color Ramp drop-down arrow and click a new
color ramp.

7

2

Now you can see the interpolated surface of CS137
contamination, along with the thyroid cancer rate data.

3
24
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Next, you will select the province centers with the highest
rates of thyroid cancer.

1. Click Selection and click Select By Attributes.

1

2. Click the Layer drop-down arrow and click
ThyroidCancerRates.
3. Double-click INCID1000 in the Fields list.

2
Selecting features by an attribute
Sometimes it is important to focus on a specific set of data
or specific features. You can select features in a scene by
their location, by their attributes, or by clicking them with
the Select Features tool. You will select the province
centers by attribute to find the locations with the highest
rates.

3
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4. Click the >= button.

4
The province centers with thyroid cancer rates greater
than 0.5 cases per 1,000 are now selected in the scene.
They are drawn in light blue to indicate that they are
selected.

6

Viewing the attributes of features
You will investigate attributes of the selected locations and
find out how many cases of thyroid cancer occurred in
these districts.
1. Right-click ThyroidCancerRates and click Open
Attribute Table.

7

8

5. Type “0.5”.

1

6. Check the selection expression you’ve built.
7. Click Apply.
8. Click Close.
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2. Click the Selected button.

4. Right-click CASES and click Statistics.

4

2
The table now shows only those features that you
selected.
3. Right-click CASES and click Sort Ascending.

The total number of cases in the selected set of
11 province centers is 176.
5. Close the Selection Statistics dialog box.

5

3

The selected province centers are sorted according to
the number of cases.
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6. Click the Navigate button and click on the scene.

In this exercise you have created 3D features, extruded
point features, and interpolated a raster surface from a set
of data points. You’ve compared the extruded vector data to
the surface data and explored the attributes of the vector
data.

6

You can work in ArcScene while the attribute table is
open.
7. Click the Save button.

7
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Exercise 4: Building a TIN to represent terrain
The town of Horse Cave, Kentucky, is situated above a
cave that once served as the source of drinking water and
hydroelectric power for the town. Unfortunately, the
groundwater that flows in the cave was polluted by
household and industrial waste dumped on the surface and
washed into sinkholes. Dye tracing studies and a threedimensional survey of the cave revealed the relationship
between the cave passages and the town and demonstrated
the connection between open surface dump sites and
contamination of the groundwater in the cave below.
Thanks to the development in 1989 of a new regional
sewage facility and the joint efforts of the Cave Research
Foundation and the American Cave Conservation
Association (ACCA), the groundwater is cleaner, and the
cave has been restored. It is now operated as a tour cave
and educational site by the ACCA.

1. Click File and click Open.

1

2. Navigate to the Exercise4 folder and double-click
BuildTIN.sxd.

2

Cave data was provided courtesy of the ACCA.
Viewing the cave and the landscape
First you will open the BuildTIN scene and view the cave
survey and some terrain data layers. You’ll use this terrain
data to create a TIN and drape some other layers on it to
visualize the relationship of the cave to the town.

The scene opens, and you can see the location of roads
and railroads, some sample elevation points, and a few
significant contour lines. In the table of contents, you
can see that some layers have been turned off.
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3. Check the box to show the Cavesurvey layer.

1. Click 3D Analyst, point to Create/Modify TIN, and click
Create TIN From Features.

1
3
2. Check vipoints point.

4

4. Right-click Cavesurvey and click Zoom To Layer.

The SPOT field name appears in the Height source
drop-down list, and the layer will be triangulated as
mass points.
3. Change the default path so that the new TIN will be
created in the Exercise 4\Terraindata\ folder and call it
tin1.

The cave survey data consists of PolylineZ features,
which are automatically drawn in 3D because they have
z-values embedded in their geometry. They appear
above the rest of the data because all of the other layers
are drawn with the default elevation of 0.

2

In the next steps you will build a TIN to provide the
base heights for the streets and a photo of the town.
Creating a TIN from point data

3

You have a point layer called vipoints point. This coverage
consists of points with an attribute called SPOT that
contains elevation values taken at these points. You’ll
create the TIN surface model from these points.

4
4. Click OK.
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The TIN is created and added to the scene. Note that it is
drawn above the Cavesurvey layer; the elevation values in
the TIN define its base height.

6

7

By default, the TIN is symbolized using a single color for
every face.
5. Right-click the tin1 layer in the table of contents and
click Properties.

8. Click the Face Elevation with graduated color ramp
option and click Add.

6. Click the Symbology tab.
You can see there is a single renderer in place, titled
Faces.
7. Click the Add button to open up the Add Renderer
dialog box.

8

9

9. Click Dismiss to close the Add Renderer dialog box and
return to the Layer Properties dialog box.

ARCGIS 3D ANALYST TUTORIAL

3Danalyst_tutorial_3.pmd

31

31

5/5/2008, 8:19 AM

If the symbol for the highest elevation range is set to blue
instead of white, then right-click on any of the symbols and
click Flip Symbols.

This will switch the order of the symbols and render the
highest points of the TIN as snow capped peaks.
10. Switch off the original single color renderer by
unchecking the Faces checkbox in the list of renderers.

Q

While this TIN is a fairly good model of the surface, you
can make it more accurate by adding more features.
Adding features to a TIN
Now you will add hard and soft breaklines and a clip
polygon to the TIN. You’ll add the railroad features as soft
breaklines, so they’ll be represented on the surface but
won’t influence the shape of the surface. You’ll add the
brklines features as hard breaklines with elevation values to
refine the shape of the surface in areas that you’re most
interested in. Finally, you will add the smclp polygon as a
soft clip polygon to more smoothly define the edge of the
TIN.

11. Click OK to close the Layer Properties dialog box.
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1. Click 3D Analyst, point to Create/Modify TIN, and click
Add Feature to TIN.

5. Check brklines.

1

5
2. Check railroad.
3. Click the Height source drop-down arrow and click
<None>.

The Add Features To TIN tool detects that there is an
ELEVATION field and uses it for the height source. You
will accept the default and triangulate them as hard
breaklines.
6. Check smclp.

2

3
4

4. Click the Triangulate as drop-down arrow and click soft
line.

6
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7. Click the Height source drop-down arrow and click
<None>.

After the next step you will see that the railroad follows a
bed that has been leveled somewhat relative to the surface.

8. Click the Tag value field drop-down arrow and click
<None>.

Setting feature base heights from the TIN

You have defined the feature layers that you want to add
to your TIN and specified how they should be integrated
into the triangulation.

Now you will set the base heights for the road and railroad
features from the new TIN.
1. Right-click roads and click Properties.

1
7
8

9
9. Click OK.
The new features are added to the TIN.
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6. Right-click railroad and click Properties.

2. Click the Base Heights tab.
3. Click Obtain heights for layer from surface.
4. Click the drop-down arrow and click tin1.

3

6

2

4
7. Click Obtain heights for layer from surface.

7

5
5. Click OK.
The road features are now draped over the TIN surface
that you created. Now you will drape the railroad
features over the surface.

8
8. Click OK.
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The railroad features are now draped over the TIN
surface that you created.

2. Click the Base Heights tab.
3. Click Obtain heights for layer from surface.
4. Click the drop-down arrow and click tin1.

3

2

4
Next you’ll drape the aerial photo over the TIN.
Setting raster base heights from the TIN
Including the aerial photo of the town in the scene makes
the relationship between the cave and the town much more
evident. You’ll drape the raster over the TIN and make it
partly transparent so that you’ll be able to see the cave
beneath the surface.

5. Click the Display tab.
6. Type “30” in the Transparency text box.

65

1. Right-click photo.tif and click Properties.

1
7
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5. Type “5” in the Width box.

7. Click OK.
8. Check photo.tif in the table of contents so it becomes
visible in the scene.
Now the aerial photo is 30 percent transparent. You can see
large patches of the TIN over the photo because the TIN
and the photo have the same drawing priority. If you
wanted the TIN to be visible below the photo, you could
change its drawing priority to 10 (lowest) on the Rendering
tab of the TIN’s Layer Properties dialog box. You could
also offset the base height of the TIN or the photo by a
small amount.

5

Cleaning up the scene
To clean up the scene you’ll turn off some layers that are
no longer needed and make the cave line symbol larger.
1. Uncheck vipoints point.
2. Uncheck brklines.
3. Uncheck tin1.
4. Click the line symbol for the Cavesurvey layer.

6
6. Click OK.
Now you can see the three-dimensional passages of the
cave, symbolized by thick lines. The surface features
and the aerial photo provide context, so you can easily
see the relationship of the cave to the town.

1
2
4
3
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Creating a profile of the terrain
The cave follows the valley floor orientation. To get an
understanding of the shape of the valley, you will create a
profile across the TIN. In order to create a profile, you
must first have a 3D line (feature or graphic). You will start
ArcMap, copy the TIN to the map, and digitize a line to
make your profile.
1. Click the Launch ArcMap button.

Now you will add the 3D Analyst toolbar to ArcMap. The
ArcMap 3D Analyst toolbar contains a few tools that do
not appear on the ArcScene 3D Analyst toolbar. Two of
these are the Interpolate Line tool and the Create Profile
Graph tool, which you will use to create your profile of the
surface.
3. Right-click on one of the ArcMap toolbars and click
3D Analyst.

1
3
ArcMap starts.
2. Click OK to launch a new empty map.

The 3D Analyst toolbar appears.
4. Click Tools and click Extensions.

2
4
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8. Right-click Layers in the ArcMap table of contents and
click Paste Layer(s).

5. Check 3D Analyst.
6. Click Close.

5

8

6

9. Check tin1 in the ArcMap table of contents to make the
layer visible.

The 3D Analyst extension is enabled.
7. Right-click tin1 in the ArcScene table of contents and
click Copy.

9

7

10. Click the Interpolate Line button.

Q
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11. Click the upper-left corner of the TIN, drag the line to
the lower-right corner, and double-click to stop
digitizing.

The profile graph is created.

W

You can edit the title, subtitle, and other properties of
the graph; you can save, print, or export the graph; you
can copy it to the clipboard; and you can show the
graph on the layout. You can also simply close the
graph.
13. Right-click the Profile Graph Title bar and click Add to
Layout.

T

You can create a profile along a line with more than one
segment, but in this case you’ll just make one straight
line.
12. Click the Create Profile Graph button.

R
E

14. Close the profile graph window.
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You can see the graph on the layout of the map.

2. Type “2” in the Observer offset text box.

2

The line of sight will be calculated to show what is
visible from the perspective of an observer two meters
tall, as the z units for this scene are meters.
3. Click on the south slope of the higher land in the upperright part of the TIN (the observer point), drag the line
to the lower-right part, and release the mouse button
(the target point).

Y
15. Click the Data View button to return to data view.

3

Creating a line of sight on the terrain
Another way of understanding the terrain is to create a line
of sight. Lines of sight show what parts of a surface are
visible and what parts are hidden along a line from an
observer point to a target point.
1. Click the Create Line of Sight button.

1
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The line of sight is calculated. The green segments show
areas that are visible from the observer point; the red
segments are hidden from the observer.

Lines of sight, like other graphic lines, can be copied
from ArcMap to ArcScene. Now you will copy both the
lines you’ve created into the scene.
5. Click Edit and click Select All Elements.

5
Both of the lines you created are selected.
4. Close the Line Of Sight dialog box.

6. Click Edit and click Copy.

4

6
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7. Click Edit in ArcScene and click Paste.

8. Click the Save button in ArcScene.

8

7

9. Click File in ArcMap and click Exit.

The lines are pasted into the scene.

9
10. Click No.

If necessary, to unselect the lines, click Selection from
the Main menu and click Clear selected features.

Q
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In this exercise you learned how to create and work with a
TIN surface model using ArcScene and ArcMap. You
discovered how to construct and symbolize a TIN dataset to
accurately represent a 3D surface. Breaklines and
polygons were added to additionally depict surface
features, such as railroads and terrain elevation values.
Further surface analysis was then conducted using aerial
photography as a draped raster layer on the TIN. Finally,
you completed the exercise conducting 3D surface analysis
on the TIN model using the interpolate line and create
profile graph tools in ArcMap.
Now that you’ve learned how to represent a surface using a
TIN model, you can begin to explore other areas of the
ArcGIS 3D Analyst extension. In the next exercise, you
will learn how to create and work with animations in
ArcGlobe.

44
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Exercise 5: Working with animations
Imagine that you wish to create an animated sequence
showing the flight of an object over a landscape. You’ve
created a TIN and have draped images over it to show the
area. You also have some data pertaining to a strange
phenomenon that has been occurring in the region. You are
interested in displaying all the data in a dynamic way,
making an animation to tour points of interest, and showing
how you made the surface. You would also like to model
the phenomenon by moving a layer in the scene.

1. In ArcScene, click File and click Open.

1
2. Navigate to the Exercise5 folder and double-click Final
Animation_A.sxd.

The tutorial data has already been assembled in the scene
document named Animation.sxd. You will use animation
tools in ArcScene to effectively convey the points you want
to show.

2

Data was supplied courtesy of MassGIS, Commonwealth
of Massachusetts Executive Office of Environmental
Affairs.
In this exercise, you will play an existing animation in an
ArcScene document, Final Animation_A.sxd, and perform
the tasks typically used to create the animation. Note that
the majority of steps you’ll perform in ArcScene to create
the animation are also applicable in ArcGlobe.

This scene contains geographic information and
recorded special effects that have been combined to
make an animation.

Opening the Final Animation_A scene document
In this section, you’ll play an animation that demonstrates
some effects you can create when you animate a scene.
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Playing the scene’s animation
In order to view a scene’s animation, you need to turn on
the Animation toolbar.

This animation shows the flight of a hypothetical
unidentified flying object (UFO) over the terrain.
3. Click the Play button.

1. Click View, point to Toolbars, and click Animation.

3
The animation plays, illustrating some of the effects you
can use in an animated scene.

1
The Animation toolbar appears. Now you’ll play the
animation.
2. Click the Open Animation Controls button.

2
In the next section you will work through the steps used
to make animations like this one.
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Opening the Animation scene document
1. In ArcScene, click File and click Open.

The scene contains an ortho photo, a scanned
topographic map, and other data you need to make your
animation.

1

2. Navigate to the Exercise 5 folder and double-click
Animation.sxd.

2
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In this section, you’ll use the animation tools to capture
keyframes, import tracks, play back your animations, and
save them to a scene document.

For a camera keyframe, the object is the virtual camera
through which you view the scene. Navigating the scene
changes camera properties that determine its position.

There are three types of keyframes that you can use to
build animations. The first is a camera keyframe. A camera
keyframe is a snapshot of the view you see in a scene. The
second, a layer keyframe, is a snapshot of a layer’s
properties. The third type is a scene keyframe, which stores
properties of a scene. In this section, you will create a
simple animation from a set of camera keyframes.

ArcScene interpolates a camera path between
keyframes, so you’ll need to capture more views to
make a track that shows animation.
2. Right-click on UFO.lyr and click Zoom To Layer.

2

Capturing perspective views as keyframes to
make an animation
The simplest way to make animations is by capturing views
to be stored as keyframes. The captured views are
snapshots of camera perspectives in a scene at a particular
time. The most fundamental element of an animation is a
keyframe. Keyframes are used as snapshots to interpolate
in between a track. You’ll create a set of keyframes to make
a camera track that will show an animation between points
of interest in your study area.
1. Click the Capture View button to create a camera
keyframe showing the full extent of the scene.

3. Click the Capture View button to create a camera
keyframe showing the UFO layer.

3
4. Click the Full Extent button to view all the data.

4
1

48

3Danalyst_tutorial_3.pmd

ARCGIS 3D ANALYST TUTORIAL

48

5/5/2008, 8:19 AM

5. Click Zoom In on the Navigation toolbar and zoom to
Goss Heights, located near the center of your view.

8. Zoom to Littleville Lake.

8
5

6. Click the Capture View button to create a camera
keyframe of Goss Heights.

9. Click the Capture View button to capture a view of
Littleville Lake.

9

6

10. Click the Full Extent button.
7. Click the Full Extent button.

Q

7
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The captured views you just made are stored as a set of
camera keyframes in a camera track. When the track is
played, it shows a smooth animation between the
keyframes. Next, you’ll play your animation track.

3. Click the Play button.

Playing back your animation
You will play back animations using simple tools that
resemble the controls of a video cassette recorder (VCR).
1. Click the Open Animation Controls button.

1

3
An animation is played back by interpolating the camera
position between the keyframes in the track. In this case,
the animation shows a virtual tour through the views
you captured.

2. Click the Animation toolbar and drag it to the lower-left
corner of the scene so it won’t block your view of the
tools or data.

2
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Clearing an animation

Recording navigation

If you want to start over, you can erase all the tracks you
created. In this section, you’ll remove the tracks you just
created so you can improve your animation.

Another way to create a camera track for an animation is to
record in real time while you navigate in a scene. In this
section, you will record your view of the scene while you
navigate using the Fly tool.

1. Click Animation and click Clear Animation.
All animation tracks are removed from the scene.

1. Click the Fly tool on the navigation toolbar.
The Fly tool allows you to fly through your scenes.

1

1
2. Click the Record button to start recording your
navigation.

2
ArcScene begins recording as soon as you click the
Record button. If you don’t navigate right away, your
track will reflect this.
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3. Click once in the center of the scene to activate the Fly
tool. You start flying by entering into hovering mode.

5. Press Esc to stop flying.
You can also stop flying by clicking until your speed is
zero.
6. Click the Stop button to finish recording.

3
6

In this mode your viewpoint follows the cursor. Point in
the direction you wish to look.
4. Click once more to begin flying through the scene.
Point in the direction you want to move. Click again to
increase your speed and right-click to decrease your
speed. Your speed is indicated in the status bar in the
lower-left corner of the ArcScene window.

You have recorded your flight path through the scene as
a new camera track that began when you clicked the
Record button and ended when you clicked the Stop
button.
7. Click the Full Extent button.

7
8. Click the Play button to see the animation you recorded.

4
8
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When you are done viewing the animation you recorded,
clear the track so you can make a better one in the next
section.
9. Click Animation and click Clear Animation.

Making a camera track from 3D bookmarks
In the previous sections, you navigated in a scene and
created keyframes to build a camera track. Another way to
create the keyframes for a camera track is to import
bookmarked perspective views of a scene. In this section,
you’ll create keyframes from 3D bookmarks.
1. Click Animation and click Create Keyframe.

9

1
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2. Click the Type drop-down arrow and choose Camera.

5. Check Import from bookmark.

3. Click New to create a new track.

6. Click the Import from bookmark drop-down arrow and
click Goss Heights.

4. Click Create.

2
5

6

3

7

4
You’ve now created a camera track with one camera
keyframe showing the full extent of your scene. You’ll
need to add more keyframes to your track so that it will
show animation. Now, you’ll import bookmarks to
create the keyframes for the rest of the animation.

7. Click Create to make the second keyframe in your track.
8. Click the Import from bookmark drop-down arrow and
choose LittleVilleDam.
9. Click Create to import this bookmark as a keyframe.
10. Click the Import from bookmark drop-down arrow and
click Knightville.
11. Click Create to make the Knightville keyframe.
12. Click the Import from bookmark drop-down arrow once
more and click Overview.
13. Click Create to import a keyframe showing all the data.
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14. Click Close.
15. Click the Play button.

Switching the visibility between layers using a
group animation
Now that you have explored some of the ways to create an
animated camera track from keyframes, you’ll learn how to
change the way layers in a scene are displayed during
animation. In this section, you will switch the layer that is
draped over the terrain model to show different ways of
representing the terrain.

Y

1. Click Animation and click Create Group Animation.
The camera track plays, moving the camera through the
set of keyframes you imported from existing 3D
bookmarks.

1
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2. Select the group layer named Image Data.
3. Slide the Fading transition bar about a quarter of the
way to the right.
4. Check Blend layers when fading.

Since you didn’t clear the animation track you made from
the keyframes, it plays in addition to the layer tracks you
just created. However, you can stop the camera track from
playing. You’ll do this next.
Using the Animation Manager to disable a track
from playing

5. Click OK.

The Animation Manager allows you to control many
properties of an animation. In this section, you’ll use the
Animation Manager to stop a camera track from playing.

2

1. Click Animation and click Animation Manager.

3

4
5

The Layer track you just created toggles the visibility of
successive layers to animate a progression between
them. The transition settings you modified will show a
smooth blending between the layers in the progression.

1

6. Click the Play button to watch your animation.

6
56
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3. Uncheck Camera track 1.

Using Animation Controls to adjust the playback
duration

4. Click Close.

1. Click Options.

2. Click the Tracks tab.

2

1
2. Type “10” in the Duration text box.

3

3. Click Options to close this portion of the dialog box.

3

4
You have disabled the camera track. Now it will not play as
part of the animation.

2

5. Click the Play button.

5
The animation plays again, only showing the layer tracks
this time. It may now seem that the duration of the
animation is too long. You can control the amount of time
in which an animation is played.
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4. Click the Play button.

2. Right-click Flight Path, point to Selection, then click
Select All.

4
The animation now plays more quickly.

2

Moving an object along a predefined path
One of the things an animation allows you to do is move an
object through a scene. You can add a layer containing a
model vehicle and move it through the scene along a
specified track. Note that this functionality is only
available in ArcScene.
You can choose to move a layer along a selected line
feature or graphic. The scene contains a graphic layer with
a model UFO that was created using Visual Basic code. In
the next set of steps, you’ll fly the model UFO along a
shapefile that shows its flight path.

You can also use the Select Features or Select Graphics
tools to select the path you want to use. A path is
constructed from a single selected line feature or
graphic.
3. Click Animation and click Move Layer along Path.

1. Click Flight Path in the table of contents.

1

3
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4. Click the Layer drop-down arrow and click UFO.lyr.

4
5
7

8

6
9
10. Click Import to import the selected line as a flight path.
5. Type a Vertical offset of “75”. This will make the object
appear to fly above the surface.
ArcScene can improve the simulation of flight of an
object, such as an airplane, along a path by making the
object point in the direction it is moving and by rolling
it from side to side as if it were banking. In the next
steps, you’ll define a roll for the UFO layer.
6. Click Orientation Settings to modify the layer’s position
while it’s animated.
7. Click Calculate from path to calculate the layer’s roll
based on the path’s shape.
8. Type “1” as a scale factor.

Q

9. Click OK.
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The UFO layer moves along the selected path. The
movement is stored as a set of layer keyframes in a
layer animation track. Now you’ll disable the tracks you
created previously so that just the UFO track is played.
11. Click Animation and click Animation Manager.

12. Click the Tracks tab.
13. Uncheck Group animation (Mesh).
14. Uncheck Group animation (Photo.sid).
15. Uncheck Group animation (Topo.sid).
16. Click Close.

E

R

U
W
17. Uncheck Flight Path to turn off the visibility of this
layer.

I
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18. Click the Play button.

2. Click Bookmarks then click UFO.

O
The UFO flies along the path you indicated. Next,
you’ll move the camera along a predefined path.
Creating a camera flyby from a path
You can move a camera along a flight path in the same way
you just moved a layer along a path. Next, you’ll combine
the track you made in the last step with one that will point
the camera at the UFO as it flies.

2
3. Click Animation and click Create Flyby from Path.

1. Check Flight Path, make sure the line you chose for
your path is still selected, then uncheck Flight Path.

1
3
You’ll move the camera location to a predefined
location in the center of the scene that will give you a
better vantage point from which to view the UFO layer
as it is moved.
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4. Click the third path destination option.
This option lets you observe the UFO as it moves along
the path.

Both tracks play. The UFO layer moves, and the camera
follows its movements.
7. Uncheck the Topo.sid check box to make the ortho
photo visible.

7
The animation is playing too quickly. Next, you’ll learn
how to adjust the duration that the animation is playing
to enhance the visual effect.
8. Click Options.

4

8
5
5. Click Import.
6. Click the Play button.

6
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9. Type “30” in the Duration text box.

Saving an animation in a scene document
You can save animation tracks in a scene document. In the
next step, you’ll save the animation you made in a scene
document.

9

1. Click File and click Save As.

1
2. In the File name text box, type “Animation_A.sxd”.
3. Click Save.

10. Click Options to minimize the dialog box.
11. Click the Play button.

3

Q
W

2

Now the animation plays more slowly as the UFO flies
over the terrain.

The new scene document is created, storing the
animation tracks.
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In this exercise you learned how to create and save simple
animations that help you better visualize 3D data. This
exercise focused on creating animations in ArcScene, but
the majority of steps can also be performed in ArcGlobe.
Note that the Animation toolbar is also available in
ArcMap, meaning that animations can be created in this
application. A 3D Analyst license is not required to animate
data in ArcMap. You can capture the view to create a map
view track (the ArcMap equivalent of a camera track in
ArcScene or ArcGlobe) that captures the display extent.
This allows you to create an animation where you are
zooming in and out, and panning the display. You can also
create a map layer track (the ArcMap equivalent to the
layer track in ArcScene or ArcGlobe) to create an
animation where you are altering layer visibility or
transparency.
In ArcMap, ArcScene, and ArcGlobe, you can create an
animation through time, by creating a time layer track.
Feature, netCDF and raster catalog layers can be animated
through time in all three applications. The information in a
table can be animated through time in a graph in ArcMap
only. For more information on animating through time, see
the Animation in ArcMap tutorial. ArcMap is used as the
application for this tutorial, but the steps performed can be
applied to ArcScene and ArcGlobe as well.
In the next exercise you’ll learn some basic fundamentals
to working with ArcGlobe.
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Exercise 6: ArcGlobe basics
2. Click Tools and click Options.

Navigating in ArcGlobe lets you explore your data and
teaches you how to accomplish fundamental tasks that
you’ll use later.
In this exercise, you’ll learn how to use the ArcGlobe
navigation tools and set properties that enhance your
viewing experience. This exercise assumes that you are
using ESRI-supplied default layers.
Examining the default layers in ArcGlobe
First, you’ll start ArcGlobe and learn what kind of data is
included by default.
1. Click the Start menu, point to Programs, then ArcGIS,
and click ArcGlobe.

2
3. Click the Default Layers tab to view all start-up layer
options for ArcGlobe.
4. Check Use the default layers that come with ArcGlobe.
This data is installed locally with ArcGIS and includes a
world image layer and a continents layer. Therefore,
rather than using online source data for this exercise we
will use the default data that comes with ArcGIS.

1

ArcGlobe starts and its default layers are loaded. Notice
which layers are loaded in the globe by looking at the
list in the table of contents.
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ArcGlobe categorizes layers according to their type.
Layers are classified as either elevation, draped, or
floating. Elevation layers provide relief to the globe’s
surface. Draped layers use the globe surface as the
source of their base heights. Floating layers display
independently of the globe surface and can be draped on
discrete surfaces or derive their elevation from attributes
or a constant value.

3
4

Now, look how the default layers are categorized - they
are both listed as draped layers and therefore display
directly on the globe surface.
Adding more layers
Default layers serve as a background to any data that you
want to add to ArcGlobe. Next you’ll add some local data
for the Las Vegas area.

5

1. Click the Add Data button.

1

5. Click OK.
6. Click the New Globe File button to refresh the globe
view with the new layers.

6
7. Click the Type tab in the table of contents.

7
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2. Navigate to the location of the Exercise 6 tutorial data
folder.

Changing a layer’s drawing priority in the table of
contents

3. Click las_vegas_area.img, press Shift, and click
las_vegas_strip.img.

Draped layers that have overlapping extents need to have a
drawing priority set so one layer gets drawn on top of the
other. ArcGlobe makes some assumptions to accomplish
this, using criteria such as the cell size of a raster layer.
Occasionally, you’ll need to override the ArcGlobe default
drawing priorities. One way to do this is to change the
order of draped layers as they appear in the Type page of
the table of contents.

The multiple layers are selected.
4. Click Add.
The image layers are added to ArcGlobe as draped
layers. You’ll explore them later in this exercise.

2

1. Click the Continents layer and drag it so it’s just above
the World Image layer.
A black line indicates where the layer will be placed.
2. Release the mouse pointer to drop the layer in its new
position.
The drawing priority is now set so las_vegas_area.img
and las_vegas_strip.img get drawn on top of the
Continents layer.

4
3

1

2
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Navigating in Globe mode
ArcGlobe has two viewing modes: Globe and Surface.
Globe mode allows you to navigate your data in the realm
of the whole globe and sets the camera target to the center
of the globe. Surface mode lets you work with your data at
a lower elevation, allows additional perspective viewing
characteristics, and sets the camera target on the surface of
the globe. You’ll learn how to navigate in Globe mode first,
then in Surface mode.

1. Click the globe, slowly drag up and to the right, then
release the mouse pointer.

1

The Navigate tool is active when you start ArcGlobe. You
can see the names of other tools on the Tools toolbar by
hovering the pointer over the tool.
The globe rotates and the view angle lowers, so you
gain a different vantage point.

Zoom In/Out

2. Right-click and drag down.

Navigate

2

The pointer changes to the Zoom In/Out pointer, and the
view zooms in on the globe. To zoom out, right-click the
globe and drag up.
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3. Click Full Extent.

Using the Spin tools
1. Click the Spin Clockwise button.

3
1

The globe displays at full extent.
Turning on the Spin toolbar
You can use the Spin toolbar to automatically spin the
globe clockwise or counterclockwise at any speed you
wish.

The globe continuously spins clockwise around the
z-axis. You can change the speed at which it spins.
2. Click the Up arrow on the Speed text box to increase the
rate at which the globe spins.

2

1. Right-click the menu area and click Spin.

1

Continued clicks will incrementally increase the spin
rate. You can also type in a value. Click the Down arrow
to decrease the rate.
3. Click the Stop button to stop the globe from spinning.

The Spin toolbar appears as an undocked toolbar.

3
You can also press Esc to stop the globe from spinning.
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2

Finding places on the globe

4

3

If you have an Internet connection, you can find world
locations by using the ESRI Online Place Finder in the
Find dialog box.
1. Click the Find button.

1
2. Click Places.
3. Type “Las Vegas” in the Place Name text box.
4. Click Find.
5. Right-click Las Vegas, Nevada, United States, and click
Create Bookmark.

5

6. Right-click Las Vegas, Nevada, United States, and click
Zoom To.
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7. Click Cancel to close the Find dialog box.

8

1

The Find tool is an easy way of locating almost any place
in the world. Use it to locate points of interest, then use
bookmarks to save perspectives of these places.
Now that you’re zoomed close to the globe surface, you’ll
learn how to navigate in Surface mode.

2. Click the Center on Target button.

Navigating in Surface mode
When you zoom in close to your data, you can switch to
Surface mode to make your navigation apply more
correctly to your new environment. Switching to Surface
mode places the camera target on the globe surface and
gives you a sense of 3D perspective while you navigate
your data.

2
3. Click the center of the Fountains of Bellagio.

3

1. Right-click las_vegas_strip.img in the table of contents
and click Zoom To Layer.
The display zooms to the Strip area of Las Vegas.

The point you clicked is moved to the center of the
display. Centering on a target sets a target on the globe
surface and switches to Surface mode.
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4. Click Zoom to Target and click the central dome of the
Bellagio.

The globe rotates, and the viewing angle lowers. The
horizon becomes visible with a light blue background,
and you view the globe in a new perspective.
7. Click the Full Extent button to return the globe to its full
extent position.

4
7
Setting some preferences

A new target is centered and the display is zoomed to it.
5. Click the Navigate button.

You can modify the way ArcGlobe functions at both the
application and globe levels. First, you’ll explore some
application-level options.
1. Click Tools and click Options.

5
6. Click the bottom of the display and slowly drag up.

6

1
The Options dialog box is where you set applicationlevel preferences. The settings will be preserved in all
instances of ArcGlobe.
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2. Click General.

5. Click Bookmarks and click Las Vegas.

3. Check Animate viewer when using tools and commands.

2
5
The display moves to the Las Vegas bookmark in a
smooth, animated transition. Next, you’ll examine a
document-level option.

3

4
This option shows smooth transitions from one view to
the next when you use tools that change your
perspective. This will be the standard behavior every
time you start ArcGlobe until you turn off the option.
4. Click OK.
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2

Setting a document-level option
1. Double-click Globe Layers in the table of contents.

1
2. Click the Background tab.
3. Click the Sky color drop-down arrow and click a color
of the morning or evening sky.

3
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Sky color is the color of the background when you zoom
in close to your globe as defined by the lower limit of
the transition zone.
4. Click OK.

4
If you switch to Surface mode and lower the viewing
angle, you’ll notice the background color changing to
the color you indicated.
In this exercise you learned how to differentiate between
ArcGlobe layer types, navigate in Globe and Surface
modes, find places, and set some application and globe
properties. Now that you’ve learned some fundamentals,
you can begin to explore other areas of ArcGlobe. In the
next exercise, you’ll learn how to use data as different
layer categories.
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Exercise 7: ArcGlobe layer classification
ArcGlobe classifies layers into three types to help you
manage them: elevation, draped, and floating. In this
exercise, you’ll learn how to use the classifications to help
layers provide the right information to your documents.
This exercise assumes that you are using ESRI-supplied
default layers.
Adding elevation layers
Elevation layers provide height information to the globe
surface. You’ll use rasters with height source information
to provide topography to the surface of the globe and
making it look more realistic.

2
3. Right-click Globe layers, point to Add Data, and click
Add elevation data.
This indicates that you want to add a specific type of
data to that layer category.

3

1. With ArcGlobe already open, click the New Globe File
button to create a new globe surface.
ArcGlobe starts, and its default layers are loaded.
4. Navigate to the location of the Exercise7 folder.
5. Select sw_usa_grid.

1

6. Click Add.

4
5

6
2. Click the Type tab in the table of contents to show the
default layer classifications.
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The raster is added to the elevation category and will be
used as a source of elevation for the globe surface.
Adding draped layers
Draped layers are placed on the globe surface and use any
elevation data present to show base heights. Next, you’ll
add images that will be draped on the globe surface in the
area you added elevation data.

3. Click Add.
If prompted, close the Geographic Coordinate
Systems warning message box. The data will be
projected to ArcGlobe’s currently set Geographic
Coordinate System.

1. Right-click Globe layers, point to Add Data, and click
Add draped data.

1

Layers you will now add will follow the globe surface.
2. Click angelus oaks.tif, press Ctrl, and click
socal_mmosaic.sid.

2

3
Both layers are selected.
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4. Right-click angelus oaks.tif and click Zoom To Layer.
The display zooms to the extent of the layer. A few
moments will pass before the layer is shown at full
resolution as the on-demand cache is built. Once the
cache is built, you’ll be able to revisit the area and
display the layer quickly.

1. Click the Continents layer and drag it so it’s just above
the World Image layer.
A black line indicates where the layer will be placed.
2. Release the mouse pointer to drop the layer in its new
position.

1
4
2

The Angelus Oaks imagery appears washed out due to the
Continents layer being drawn with a higher drawing
priority. Next, you’ll learn how to change the drawing
priority of a draped layer.

The drawing priority is now set so angelus oaks.tif and
socal_mmosaic.sid are drawn on top of the Continents
layer.

Changing the drawing priority of a layer in the
table of contents
Draped layers that have overlapping extents need to have a
drawing priority set so one layer gets drawn on top of the
other. ArcGlobe makes some assumptions to accomplish
this, using criteria such as the cell size of a raster layer.
Occasionally, you’ll need to override the ArcGlobe default
drawing priorities. One way to do this is to change the
order of draped layers as they appear in the Type page of
the table of contents.
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Setting a target to initiate Surface mode

2. Click the bottom of the display and slowly drag up.
The globe terrain you created becomes discernible as
you investigate the imagery you added.

1. Press Ctrl and click the middle of the display.

2

1

You’ve initiated Surface mode and set a target at the
location on the globe surface where you clicked.

3. Click the Full Extent button to return the display to the
original view.

3
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Adding floating layers

Setting elevation properties of floating layers

Floating layers are layers that float independently of the
globe surface. Next, you’ll add a raster as a floating layer
and set it to elevations not connected with the globe
surface.

1. Right-click o3_99x10k and click Properties.

1. Right-click Globe layers, point to Add Data, and click
Add floating data.

1

1
2. Click o3_99x10k.
o3_99x10k is a raster showing average annual ozone
concentration for 1999 in California.
3. Click Add.
The layer is added to the floating category.

2

3
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2. Click the Elevation tab.

5. Click Symbology.

3. Click Elevation values provided by this layer in the
Layer floats independent of the globe surface, draped
on drop-down menu.

6. Select the red to blue color ramp in the Color Ramp
drop-down menu.
7. Check Invert.

4. Type “5000” in the Add a constant elevation offset in
meters text box.

5

2
6
3

7

4
8
This inverts the color ramp so that high values will be
displayed as red, low values as blue.
8. Click OK.
You’ve set the raster to use its own values as a source of
base heights, offset those heights 5,000 meters from the
globe surface, and symbolized the concentration values
with color. Next you’ll take a look at how this appears
in the display and set a vertical exaggeration to
accentuate the elevation.
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Setting a vertical exaggeration factor for floating
layers

3. Click the bottom of the display and slowly drag the
mouse pointer up.

1. Right-click o3_99x10k and click Zoom To Layer.

3

1

This allows you to see the effect of changing the
vertical exaggeration.
The layer is displayed in the view.

4. Double-click Globe layers.

2. Click the Navigation Mode button to change the mode
to Surface navigation.

4

2
5. Click the General tab.
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6. Select or type a value of “10” in the Vertical
Exaggeration Of floating layers drop-down menu.

5

Examine the floating layer you created. You’ll see a 3D
raster showing average ozone concentrations in
California in 1999. The layer floats above the state of
California and is a surface that is different from the
terrain below.
In this exercise, you learned how to differentiate layer
types in ArcGlobe, saw the effect they have on the globe,
and set properties to improve their display. Explore
Exercise7.3dd globe document in the Exercise7 folder to
discover additional ways to enhance your globe documents.
The document contains layers saved with custom settings,
bookmarks, globe lighting, and animation tracks.

6

7
The floating layer will be exaggerated by a factor of 10.
7. Click OK.
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Exercise 8: Creating and using a terrain dataset
A terrain dataset is a multiresolution TIN-based surface
derived from measurements stored in one or more feature
classes in a geodatabase.
In this exercise, you will use geoprocessing tools to load
surface data into a geodatabase, construct a terrain dataset,
and use the terrain inside ArcMap and ArcGlobe.
Loading surface feature data into a geodatabase
In this scenario, you have LIDAR points and
photogrammetric breaklines stored in two separate ASCII
text files. This data will be used to construct your terrain
dataset. To accomplish this, you need to import them into
feature classes that reside in a feature dataset. The terrain
will be generated in the same location as the source data.

2. Navigate to the Exercise 8 folder and click terrain.gdb
to open the geodatabase. Double-click the topography
feature dataset to open it.

You’ve been provided a file geodatabase with a feature
dataset. It contains two polygon feature classes: one is for
lakes, the other to delineate the study area. The initial step
will be to import the two ASCII files into the feature
dataset as feature classes: one feature class will delineate
the photogrammetric breaklines, while the other feature
class will contain the LIDAR points.
1. Start ArcCatalog.
Make sure the 3D Analyst extension is enabled via the
Tools>Extensions dialog box.

2
3. Open ArcToolbox by selecting Show/Hide ArcToolbox
Window from the Main menu.

3

4. In the ArcToolbox window, choose the plus sign next to
the 3D Analyst Tools to expand the tools located in the
3D Analyst toolset.
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7. In the ASCII 3D to Feature Class tool, make sure the
Browse for drop-down list is set to Files.

4
5

6

8. Click the Browse button next to the Input dialog box,
navigate to the Exercise 8 folder, and choose the
masspoints.xyz file as input.

7
8

5. From the 3D Analyst toolset, expand the Conversion
tools, then the From File tools.

9
Q
W

6. Double-click ASCII 3D to Feature Class to open the
geoprocessing tool.
Next you’ll convert the ASCII points from a simple text file
in XYZ format into a multipoint feature class. These points
only define surface geometry. The attributes only contain
x,y, and z values.
A multipoint feature class stores one point per line, and the
coordinates are separated by spaces. Since there is no
attribution associated with these points, dedicating a
database row for each is wasteful and inefficient. Instead,
you’ll combine them into multipoints.
A multipoint can store many points per shape or row,
saving storage space and improving read–write
performance.

E
R
9. Make sure the Input File Format to XYZ.
10. Click the Browse button next to the Output Feature
Class dialog box and navigate to the topography feature
dataset.
Name the output feature class topo_mass_points and
save it inside the topography feature dataset.
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11. If not already, set the Output Feature Class Type to
MULTIPOINT.

14. Double-click ASCII 3D to Feature Class to open the
geoprocessing tool.

12. Set the Average Point Spacing to 10.

15. Make sure the Browse for drop-down list is set to Files.

The point spacing represents the average distance
between measurement points. Sometimes this is
referred to as nominal point spacing. This is given in
the xy units of the data.

16. Click the Browse button and choose the breaklines.lin
file as input.

The average point spacing option is only available
when the Output Feature Class Type parameter is set to
MULTIPOINT. It facilitates the clustering of points so
that each output multipoint is made from points that are
relatively close to one another.

U

13. Accept all other defaults and click OK to execute the
geoprocessing tool.

I
O
P

In the next step, you’ll use the same ASCII 3D to Feature
Class tool to import the ASCII breakline data.
Breaklines are linear features, such as roads and water
body shorelines, which need to be represented on the
surface. The breaklines are provided in the 3-D
GENERATE format—an ASCII format similar to XYZ but
more appropriate for line and polygon data.
You can find a detailed description of the GENERATE
format in the help. To find it, click the Learn more about
link located at the top of the help page for the ASCII 3D to
Feature Class tool.

A
17. Set the Input File Format to GENERATE.
18. Click the Browse button for the Output Feature Class
and browse to the topography feature dataset. Name the
output feature class topo_break_lines.
19. Set the Output Feature Class Type to POLYLINE.
20. Click OK to execute the geoprocessing tool.

86

3Danalyst_tutorial_3.pmd

ARCGIS 3D ANALYST TUTORIAL

86

5/5/2008, 8:19 AM

In ArcCatalog confirm the breaklines have been created
correctly.
21. Click to select the topo_break_lines feature class in the
catalog tree.
22. Click the Preview tab to view the breakline data.

D

If you need to process a large collection of LIDAR points,
consider using the LAS format instead of XYZ. LAS is an
industry-standard format for LIDAR data. It’s more
efficient because it’s binary. It also has more information
stored in the file about the data.
There’s a separate tool to import LAS format files, LAS to
Multipoint, that’s located in the same toolset as the ASCII
3D to Feature Class tool.
Building a terrain dataset from features
Next you will use the Terrain wizard in ArcCatalog to
define and build a terrain dataset.
1. In ArcCatalog right-click the topography feature dataset
and select New>Terrain from the context menu.

S

1
F

23. Make sure the preview type is set to Geography. The
preview should resemble the breakline data displayed in
the above image.
Now you’ve loaded the mass points and breaklines from
which a terrain dataset will be built. The LIDAR points
came in XYZ format and the photogrammetric lines in 3-D
GENERATE format. Both are ASCII formats for simple
3-D data and are read using the same tool, ASCII 3D to
Feature Class.

Terrains are located in feature datasets. Terrains, and the
feature classes used to build them, must reside at the same
location. One benefit of using the feature dataset as a
container is that it ensures all the data used to build a
terrain has the same spatial reference. In an SDE database,
it’s also the organizational level at which data gets
registered as versioned for editing.
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2. Accept the default name for the terrain dataset.
3. Click Select All to check on all the feature classes that
are in the feature dataset.

7. Set the Surface Feature Type (SFType) to hard line for
the topo_water_poly Feature class.

2
3

7
6
8

4

5

4. Set the Approximate point spacing to 10.
5. Click Next and indicate how each feature class will
contribute to the terrain.
6. Click the Advanced button to expand the list of
columns.

The features of the topo_water_poly feature class
should be incorporated into the surface as hard lines.
Since the mass points and breaklines have z-values,
which will be used to define the terrain surface, so the
height source for them is set to Shape. This means
that z comes from the shape geometry.
The topo_clip_poly feature class contains a 2D polygon.
It defines the horizontal extent of the surface and
minimizes interpolation artifacts around the surface
perimeter.
Clip polygons work best when they’re smaller than the
extent of the data that is being used to provide z-values.
The water polygons are represented by 2D geometry but
have the height attribute SPOT. Each polygon can have
its own height, but that height is constant. For lakes, this
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is fine, since they’re flat. With this data, there are no
measurements inside the lake boundaries that contradict
the lake SPOT values, so you can add the boundaries as
breaklines; otherwise, they’d be added as replace
polygons to ensure their areas get flattened.
Everything but the breaklines are used for the terrain’s
overview representation. The overview is a generalized
representation of the terrain, similar to a vector-based
thumbnail. The breaklines are too detailed for the
overview, but all the other information is needed to
produce a reasonable looking overview.

1. Click the radio button next to the z-tolerance pyramid
type.

1

8. Click Next to determine the terrain pyramid type.
Defining the pyramid for the terrain dataset
Terrain pyramids are used to create multiresolution
surfaces. They’re similar to raster pyramids in concept (that
is, coarser pyramids are used for display at smaller scales
to improve display performance), but there are differences.
The most significant are that they’re composed of vectorbased measurements and they can be used for analysis as
well as display.
Two types of pyramids can be used to build a terrain
dataset: z-tolerance and window size.
Z-tolerance pyramiding thins points to produce surfaces
that are within an approximate vertical accuracy relative to
the full resolution data.

2
The z-tolerance pyramid type is defined using two factors:
z-tolerance and reference scale.
The z-tolerance of an individual pyramid level represents
its approximate vertical accuracy relative to the full
resolution data. The reference scale of a pyramid level
defines the display scale at which it becomes active.
2. Click Next to define the terrain pyramid levels.

The window size pyramid type thins points for each
pyramid level by partitioning the data into equal areas
(windows) and selecting just one or two points from each
area as representatives. Selection is based on one of the
following criteria: the minimum, maximum, mean, or both
the minimum and maximum z value.
ARCGIS 3D ANALYST TUTORIAL
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3. Click Add four times. This populates the table for you to
customize the properties.
4. Manually reset the values for Z Tolerance and
Maximum Scale by clicking the values inside each
column. Use the values specified in the following
graphic.

3
4

Tolerances and scales used to define a terrain pyramid need
to be specified based on application requirements. One
approach is to mimic the accuracy requirements of a
contour map series. A generally accepted rule is that
contours should be accurate to within one-half of their
interval. For example, if a 1:24,000 scale map within your
study area uses a 5-foot contour interval, then the vertical
accuracy should be 2.5 units RMSE. Base the pyramid on
the scales and contour intervals appropriate for a map
series of the terrain.
While breakline vertices are used where needed through all
pyramid levels, the actual line enforcement can be
restricted to occur in a subset of these levels. For example,
road curbsides need not be enforced as triangle edges in a
terrain at scales smaller than 1:24,000. You control
enforcement via the Pyramid Bounds dialog box.
5. Click the Resolution Bounds Setting button to open the
Pyramid Resolution Bounds dialog box.

8

5

Using these settings, the full resolution data is used in map
displays up to a scale of 1:2,500. Between display scales of
1:2,500 and 1:10,000, only the data necessary to achieve an
approximate vertical tolerance of 1.0, relative to the
full-resolution data, is used. Between 1:10,000 and
1:25,000, a tolerance of 2.5 is used. Between 1:25,000 and
1:50,000, a tolerance of 5 is used. For any scale smaller
than that, a tolerance of 10 is used.

6. Set the Max Z Tolerance for the topo_break_lines
feature class to 1. Accept the defaults for the others.
In the Resolution Bounds dialog box, z-tolerances indicate
at which pyramid levels the enforcement is to take place.
Using the given values, the breaklines will be enforced for
pyramid levels with z-tolerances >= 0 and <= 1.0. This
translates into the breaklines being enforced only at scales
larger than 1:10,000. The water and clip polygons are
enforced through all scales. This ensures the data boundary
is always correct and water bodies remain flat.
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6

9
7

10. You’re now asked if you want to build the terrain.
Select Yes to initiate the terrain build process.

7. Click OK to dismiss the Pyramid Resolution Bounds
dialog box.
8. Click Next to reach the summary panel.

Q

Review your settings.
9. Click Finish.

When the terrain build process is complete, the new
terrain is added to the Catalog Tree inside the feature
dataset. Right-clicking the new terrain dataset will
expose the properties. You can preview the terrain
dataset in ArcCatalog.

ARCGIS 3D ANALYST TUTORIAL

3Danalyst_tutorial_3.pmd

91

91

5/5/2008, 8:19 AM

Viewing a terrain in ArcMap
Now that you have created a terrain dataset, adding it as a
layer in ArcMap can be used to conduct further
visualization and analysis. You can turn it on and off in the
table of contents (TOC). As well, it has a Layer Properties
dialog box to control display parameters. The Symbology
tab on this dialog box is identical to TIN layers.

measurements needed to get to the higher-detail pyramid
level are retrieved and added to the triangulation.
4. Zoom in on the display. Note how the vertical tolerance
associated with the current display is listed in the map’s
Table of Contents.

1. Start ArcMap.

4

2. Click the Add Data button.

2

5. Zoom to the full extent of the layer by clicking the Full
Extent button from the Tools toolbar.

3. Browse to topography_Terrain from the Exercise 8
folder, add it to the map, then make sure its visibility is
turned on.
The terrain will retrieve measurements from the database
for the pyramid level associated with the current display
scale. The measurements are triangulated on the fly and
drawn to the screen. When going from coarser pyramid
levels to more detailed levels, only the additional

Note that Overview Terrain is listed in the Table of
Contents.
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The terrain overview is the coarsest representation of the
terrain. It’s coarser than the lowest level of detail (LOD)
pyramid specified when the terrain was defined.

6

The overview is used by default when the layer is zoomed
out to full extent or beyond. This is used to speed up
rendering. Use of the overview representation can be
turned on and off from the Display tab of the terrain’s
Layer Properties dialog box. You can also apply a point
limit from this tab.

7

The use of a point limit tells the terrain layer to further
downgrade its display resolution if the current environment
(i.e., display extent, scale, and pyramid definition) would
require too many measurement points. This helps maintain
display performance at the cost of not always honoring the
terrain’s original pyramid display definition. When the
resolution has been downgraded, an asterisk is displayed
next to the terrain layer’s name in the TOC. By default, a
point limit of 800000 is used.

From the map display, zoom in and out, then pan around.

6. Double-click the terrain layer to open the Layer
Properties dialog box and click the Display tab.

Using the interactive surface analysis tools in
ArcMap

7. Change the point limit from 800000 to 125000 and click
OK to close the Layer Properties dialog box.

Now you’ll use the 3D Interactive tools to complete some
surface analysis.

The display should be consistently fast because the layer is
adjusting which pyramid levels gets used to keep the point
count below the 125000 limit.

1. Make sure the 3D Analyst extension is enabled by
clicking its check box in the Tools>Extensions dialog
box.

1
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2. Add the 3D Analyst toolbar from the View>Tools menu,
if not already displayed. The terrain is displayed in the
Layer combo box on the toolbar.

4. Set the resolution threshold for the 3D Analyst tools to
1.0 from the drop-down menu.
5. Click OK.
6. Zoom in on the terrain until the display scale is larger
than 1:10,000.

If you aren’t zoomed in far enough, the tools on the toolbar
are disabled. By default, they’re only enabled when the
terrain is displayed at full resolution. Based on how the
terrain’s pyramid was defined, this will occur at display
scales of 1:2,500 or larger.
You can enable the tools at lower resolutions from the
Analysis tab of the terrain’s Layer Properties dialog box.
When you enable the tools at LODs lower than full
resolution, the accuracy is also decreased. Interactive tools
always operate at the current display resolution. This is
useful if the full-resolution terrain is oversampled for the
requirements of the analysis.
3. Double-click the terrain layer to open the terrain Layer
Properties dialog box and click the Analysis tab.

3
4

The 3D Analyst interactive tools on the 3D Analyst
toolbar should now be enabled.
Now you’ll conduct a Line of Sight analysis on the surface.
7. Click the Create Line of Sight tool. Set the Observer
offset to 5 and the Target offset to 2. Digitize two points
on the surface to reveal the line of sight analysis.
8. Now you’ll interpolate a 3D line on the surface. Click
the Interpolate Line button and digitize two points on
the surface.
The resulting graphic line will automatically be
selected.
A selected 3D polyline enables the Create Profile Graph
tool.

5
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9. Click the Create Profile Graph tool to graph the 3D line.

2. Choose the terrain in the Input Terrain drop-down box.
3. Set the other values to match the graphic below.

2

3

Rasterize a terrain using a geoprocessing tool
Terrain datasets can be rasterized based on any extent, cell
size, and vertical tolerance. You can choose between linear
and natural neighbor interpolators. A natural neighbor
interpolation method generally produces higher quality
results but at the expense of processing time. Rasterization
is performed using the Terrain to Raster geoprocessing tool.
1. Open the Terrain to Raster tool from the ArcToolbox
window. It’s located in the 3D Analyst
Tools>Conversion>From Terrain toolset.

4
4. Click OK to execute the geoprocessing tool.
Keeping the Output Data Type as FLOAT will preserve
vertical precision.
Changing the interpolation Method to
NATURAL_NEIGHBORS will take a little longer than
LINEAR but it adds some smoothness everywhere except
across hard breaklines where sharp discontinuities are
supposed to occur.
Setting an explicit Sampling Distance lets you know
exactly what the output cell size will be.

1

Since this terrain dataset was made with a z-tolerance
pyramid type, the pyramid resolution represents the
z-tolerance of the desired pyramid level. In this terrain, the
pyramid level with a resolution of 1.0 has the breaklines
enabled.
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This surface will be somewhat generalized relative to the
full-resolution data but not by much, and this process will
run faster because it’s using a thinned version of the data.

2

5. Zoom to full extent once the geoprocessing tool has
completed. Turn off the layers except the raster to view
the results.
To see the morphology of the derived raster surface,
generate a hillshade image. A hillshade representation of a
surface can greatly enhance the visualization of a surface
for analysis or graphical display, especially when utilizing
the transparency setting.
1. Open the 3D Analyst Tools>Raster Surface>Hillshade
geoprocessing tool.

3
4
4. Click OK to execute the tool, and examine the resulting
hillshade layer.
Using a terrain as an elevation layer in ArcGlobe
Terrain datasets can be used in ArcGlobe as either
elevation or draped layers contributing to the definition of
the globe surface.
1. Start ArcGlobe.

1

2. Right-click the Globe layers from the Table of Contents,
then point to Add Data, and click Add elevation data to
add the terrain dataset as an elevation layer.
3. If prompted, close the Geographic Coordinate Systems
Warning message box.

2. Browse to the Exercise 8 folder to specify the input
raster.
3. Confirm all other values match the graphic below.
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5
If prompted, close the Geographic Coordinate Systems
Warning message box.

3
The data will be projected to ArcGlobe’s currently set
Geographic Coordinate Systems.
The terrain dataset will be added as an elevation source
in the Table of Contents of ArcGlobe. It will not be
visible if it is used as an elevation surface to drape
additional surfaces on.
4. Add the rasterized terrain as a draped layer.
Right-click on Globe layers from the table of contents,
then point to Add Data, and click Add draped data.
Browse to the rasterized terrain and click Add.
5. A dialog box may appear requesting to build raster
pyramids. Click Yes.

6. Repeat steps 4 and 5 to add the hillshade raster as a
draped layer.
Right-click on Globe layers from the table of contents,
then point to Add Data, and click Add draped data.
Browse to the hillshade raster and click Add. A dialog
box may appear requesting to build raster pyramids.
Click Yes.
7. Click and drag the rasterized terrain until a line appears
above the hillshade indicating the new location. Release
the mouse once this line appears.
8. Right-click the rasterized terrain and click Properties.
9. Click the Symbology tab.
Symbolize the rasterized terrain using an appropriate
elevation color ramp.
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9

11. Assign a transparency setting of 50%.
12. Click OK to close the Layer Properties dialog box.

The hillshade raster can be seen through the rasterized
terrain using this transparency setting, revealing a 3D
morphological surface of the terrain dataset.

10. Click the Display tab.

Q

Optimizing display settings in ArcGlobe
For high-quality display, you can do several things. Go to
the Cache tab on the terrain’s Layer Properties dialog box
and uncheck the option to compress to 16 bits. This will
eliminate the possibility of the surface geometry looking
stair stepped when zoomed in very close.

W

You can also set both the draped layers to use bilinear
renderers. These will draw a smoother picture. Also, the
hillshade raster should not use any stretch. The default,
using standard deviations, is not appropriate for this data.

E
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As an alternative to viewing draped rasters derived from
the terrain dataset, you can add the terrain directly as a
draped layer.
To do this, right-click on Globe layers from the table of
contents, then point to Add Data and click Add draped data,
then choose the terrain.
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Exercise 9: Creating a realistic 3D view
Imagine that you are an urban planner and are interested in
constructing a realistic 3D model of a neighborhood. The
staff of the planning and transportation departments have
created GIS datasets for the building footprints, street
lights, trees, and sample vehicles for this area. You also
have imagery of the area, and an architect has supplied a
set of photorealistic building models.
You want to combine the GIS data with the image and the
building models in ArcGlobe to develop a realistic urban
model. This model will help decision makers visualize
proposed buildings and their associated view. Such models
can also be used to study spatial awareness, or to simulate
urban features, landscapes, landmarks, or tourist attractions
for students or tourists.
This is an advanced exercise illustrating how to use 3D
symbology and 3D graphics tools to create a realistic
looking view of a study area in London.

2. Navigate to the Exercise9 folder and double-click
London_Start.3dd.

2

The ArcGlobe document contains two high resolution
images (courtesy of DigitalGlobeQuickBird™), one 3D
feature dataset symbolized with tree symbols, and one
3D textured multipatch dataset representing the
buildings in the study area.
3. Click File and click Save As.

Opening the London Globe document
1. Start ArcGlobe, then click File and click Open.

3

1
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4. Type London.3dd for the name of the globe document.

1. In the Table of Contents, right-click the London.jp2
layer and click Properties.

1

5
4
2. Click the Globe General tab.
5. Click Save.

3. Click Don’t show layer when zoomed.

Setting the visible distance range of a layer
You can optimize the performance of an ArcGlobe
document by setting an appropriate visibility distance for
each layer. Specifying the visibility distance range lets you
control when a layer becomes visible as you zoom in or
out. You can either set the minimum and maximum
distance for an entire layer, or you can base the layer
visibility on individual tile distances.
The checked box beside the Buildings layer is grayed out
in the Table of Contents. This means the display currently
exceeds the layers maximum visibility distance. You will
change the maximum visibility distance for a couple of
other layers later in this exercise.

2

3
4

5
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4. Type “100” in the Out beyond text box.
The units used for this distance are kilometers.
5. Click Check visibility based on each tile distance to
enable distance visibility for discrete parts of the layer.
This setting, although not enabled by default, further
improves performance. When enabled, discrete tiles of
data appear visible when navigating near their layer’s
distance threshold.

The display is now repositioned to the City View
bookmark. All of the datasets are now visible because
you are within the visibility distance range of all layers
at this scale.
A layer’s visibility range can also be set according to
current display distances. Right-click a layer in the
Table of Contents, point to Visible distance range, and
use the Set Maximum Distance and Set Minimum
Distance commands to capture display distances.

6. Click OK.
The layer will be visible between the minimum and
maximum distance.
7. Repeat steps 1 through 6 for the Holborn.jp2 layer. Type
“5” for the maximum distance for this image.
8. Click Bookmarks and click City View.

8

Tips on allocating memory cache
Often, an ArcGlobe document that is performing poorly
can be made interactive through a well defined memory
cache. This is a specified amount of physical memory
(RAM) dedicated for exclusive use by ArcGlobe to
improve performance. For optimum performance, the
memory cache can be fine-tuned according to the
individual data types used. As this exercise uses many 3D
textured objects and raster images, your next step will be to
allocate a greater percentage of the memory cache to
improve handling these data types.
1. Click the Tools menu and click Options.

1
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2. Click the Cache tab.

• 3D objects (geometry): 100

3. Click the Advanced button.

• 3D objects (texture): 200
• Images/rasterized: 150

2

If necessary, reduce the amount of memory allocated for
other data types to prevent the size of the memory cache
from exceeding your available physical memory
(RAM).

3

Each data type’s current memory usage as an absolute
value and as a percentage of its allocated size is detailed
in the text box and horizontal graph to the right of each
item.
5. Click OK to confirm changes and close the Advanced
Memory Cache Settings dialog box.
6. Click OK to confirm changes and close the Options
dialog box.

4

The total memory cache size is automatically calculated
as the sum of the individual data type settings. This total
cannot exceed the amount of physical memory (RAM)
installed on your machine.
These values will apply to all future ArcGlobe sessions,
so you should consider all ArcGlobe documents you will
be working with when specifying memory cache
settings.

5

4. Type the following memory allocation values, in
megabytes, for each of the following memory types:

ArcGlobe will not automatically balance the allocation of
memory used for each data type. If you allocate a small
amount of physical memory (RAM) to a particular data
type and subsequently create a document that makes
extensive use of this data type, it will start paging the data
to disk well before physical memory is exhausted, leading
to reduced performance.
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Adding feature data
In order to create 3D objects on your model, you will add
some local data to the London area.
1. Click the Add Data button.

A sequence of three Add Data Wizards will appear for
each feature layer beginning with Building_Footprints.
6. Click Don’t show layer when zoomed to apply the
distance visibility range.
7. Type “3” in the out beyond text box, and leave the in
beyond text box set to the default value of “0”.

1
2. Navigate to the location of the Exercise 9 tutorial data
folder.
3. Open the Geodatabase folder, and double-click the
Lincolns.gdb geodatabase file.
4. Holding down the Ctrl key, click the
Building_Footprints, Street_Lights, and Vehicles feature
classes.

6

7

Holding down the Ctrl key lets you select multiple
items.

8
8. Click Finish.

4

9. Click Display features as 3D vectors when the Add Data
Wizard appears for Street_Lights layer.
10. Click Next.

5
5. Click Add.
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R

9

Q
11. Click Don’t show layer when zoomed to apply the
distance visibility range. Then type “1” and “0” in the
distance range text boxes.

T
14. Click Finish.
15. Repeat steps 9 through 14 for the Vehicles layer.
If prompted, close the Geographic Coordinate Systems
Warning message box. The data will be projected to
ArcGlobe’s currently set Geographic Coordinate
System.

W
E
12. Click Next.
13. Select the typical scale at which this layer will be seen.
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16. Click Bookmarks and click Bird View.
Now you can see all the layers you have added to the
study area. The Table of Contents indicates that these
feature layers have been added as draped layers in the
scene.

1. In the Table of Contents, right-click Building_Footprints
layer and click Properties.

Extruding buildings
Features in a two-dimensional data source can be projected
into a three-dimensional representation through a process
known as extrusion. A 2D building footprint, for example,
can be extruded into a 3D block representation of that
building. In this exercise, you will extrude building
polygons according to a height value governed by the
number of floors and average height per floor to create
realistic 3D building shapes.

1

2. Click the Globe Extrusion tab.
3. Check Extrude features in layer.
4. Click the Calculate Extrusion Expression button to open
the Expression Builder dialog box.
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2
3

5

4
6

8
5. Click the attribute “NUM_FLOORS” to add it to the
Expression text box.
6. Assuming that each floor has a height of 4 meters, you
can calculate the height of each building by multiplying
the number of floors in each building by 4.
Set the expression to [NUM_FLOORS] * 4 to reflect the
following graphic.

7

7. Click OK.
8. Click OK to close the Layer Properties dialog box.
The 2D building footprints features are now extruded
into 3D blocks.
Optionally, to increase performance you can choose not
to draw the bottom faces of extruded polygons.
Navigate around the display to view your results.
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5. Click Add All Values.
This adds all unique values to the list. You could also
have clicked the Add values button to choose specific
Model values to display.

3

4

2

6
Symbolizing features

5

1. In the Table of Contents, right-click the Street_Lights
layer and click Properties.
You can also open the Properties dialog box by doubleclicking the layer.
2. Click the Symbology tab.

6. Double-click the symbol for “stlght13”.

3. Click Categories.
ArcGlobe automatically selects the Unique values
option.
4. Click the Value Field drop-down arrow and click
MODEL.

108

3Danalyst_tutorial_3.pmd

ARCGIS 3D ANALYST TUTORIAL

108

5/5/2008, 8:19 AM

7. In the Symbol Selector dialog box, click the More
Symbols button, and in the list click the 3D Street
Furniture style from the list.

11. Click OK.

9

8

Q

7
R
8. Click the Category drop-down list and click Street
Scene.

W

12. Double-click the symbol for “stlght7”.

This will show only those symbols in the Street
Furniture style, so that you don’t have to scroll
through all visible symbols in the Selector list.
9. Click the “stlght13” symbol.
10. Type “8” in Size text box.
13. Repeat steps 8 through 11, type “5” for the size, and
assign “stlght7” for another street light symbol.
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Matching symbols in a style

14. In the Layer Properties dialog box, click the
Advanced button and click Rotation.

The symbols in a style have names. If your features have
values that match these names, you can automatically
associate a particular symbol with each matching feature. If
your features use a different set of names, you can edit the
names in the style to match them.

T
15. Click Rotate Points by Angle in this field drop-down
list and click Angle.

1. In the Table of Contents, right-click Vehicles layer and
click Open Attribute Table.
In the Attribute table window, notice the Model column.
Each vehicle type listed corresponds to a symbol with
the same name.

Y

U

2. Close the Attribute table.
3. Double-click the Vehicles layer to open the Layer
Properties dialog box.
4. Click the Symbology tab.

16. Click OK.
17. Click OK on the Layer Properties dialog box when you
have finished.

5. Under Categories, click Match to symbols in a style.
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6. Click the Value Field drop-down arrow and choose
MODEL.

5

6

7

8. Click Match Symbols.
This adds all unique values that have a matching symbol
in the style.

8

W

9

7. Click Browse to navigate to the 3D Vehicles.style file in
the ArcGIS\Styles folder and click Open. Match to
symbols in a Style will now be populated with this style
file.

Alternatively, by clicking Add Values, you can manually
specify which unique values to display. You can also
manually edit a label if you would like more descriptive
labels to appear in the legend and the Table of Contents.
This does not change the name in the attribute table.
9. Click the Advanced button and click Rotation.
10. Click the Rotate Points by Angle in this field dropdown list and click Angle.
11. Click OK.
12. Click OK again to close the Layer Properties dialog
box.
Navigate around the neighborhood to view the results.
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Using the graphic tools
Sometimes you need to show something that isn’t
represented among your GIS features. You can add
graphics to ArcGlobe and display them with the same
realistic symbols that you use for features. You can digitize
3D graphics to represent points of interest, lines to
delineate boundaries or roads, polygons that fill an open
area, or text to name or describe places. In order to do so,
you need to add the Globe 3D Graphics toolbar.
1. Click View, point to Toolbars, and select Globe 3D
Graphics.

You can also add/remove toolbars by right-clicking on a
toolbar or in the gray area where toolbars appear. This
opens the toolbar list. The visible toolbars are checked.
Creating a graphic layer

You can control the visibility of graphics by storing them in
a named graphics layer. The graphics layer will be listed in
the ArcGlobe Table of Contents, where you can turn it on
and off like other layers.
1. Click Bookmarks and click City Hall.
2. On the Globe 3D Graphics toolbar, click Graphics and
click New Graphics Layer.

2

1

The 3D Graphics toolbar appears.

The New Graphics Layer is added to the Table of
Contents under Draped layers.
3. Double-click the New Graphics Layer to open the Layer
Properties dialog box.
4. Type “My Buildings” in the Layer Name text box.

2. If you want to dock the toolbar along with other
toolbars, simply drag it to the desired location.

4
5. Check Don’t show layer when zoomed.
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6. Type “3” in the out beyond text box.
7. Click OK.

3
Setting the target layer and digitizing a 3D point
graphic

1. On the Globe 3D Graphics toolbar, click the Graphics
menu, point to Active Graphics Layer Target, then click
My Buildings.

4. Click the Effects tab.

1

5. Uncheck Pin to surface and Fixed screen size.

4

All new graphics will be added to this layer.
2. Click the Graphics drop-down menu and click Default
Element Properties.

5
2
6
3. Click the Marker button.
The Default Marker Element Properties dialog box
opens.

Generally Pin to surface is selected by default to pin
elements to the globe surface; however, for the purpose
of this exercise it will not be used.
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The fixed screen size option will not scale vector point
graphic elements when you zoom in and out. We
unchecked it here so the point graphic element will stay
the same size in relation to the globe as you zoom in
and out.
6. Click OK.

9

7. Click OK to close the Default Element Properties dialog
box.
8. On the Globe 3D Graphics toolbar, click the New
Marker tool.

W

Q 8
12. On the Symbol tab, click Change Symbol.
3D point graphics can be symbolized with 3D marker
symbols. You can choose these symbols from existing
styles. This is an easy way to add realistic objects to
your 3D model without editing your GIS features. Now
you will add a 3D symbol for the city hall in London.
9. Add a point as highlighted in the following graphic.

E

A point graphic is drawn at the location you digitized.
10. Click the Select Graphics tool.
11. Right-click the point and click Properties.
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13. In the Symbol Selector dialog box, click the More
Symbols button and click 3D Buildings style.

I

A

14. Click the Category drop-down list and click
Institutional.
15. Click the “cityHall1”symbol, and type “25” in the
Angle box.
16. Click Properties.

O
Y
U

P

The dimension of the cityHall1 symbol is modified in
the 3D Preview window.
20. Click the 3D Placement tab.
21. Type “3” for the X offset, and “-5” for the Y offset.

17. In the Symbol Property Editor, make sure that the 3D
Marker tab is selected.
18. Uncheck Keep aspect ratio to allow the dimensions of
the 3D symbol to be freely adjusted.
19. Under Dimensions, type “70” in the text box for
Depth (Y).
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S

D
The 3D symbol is offset in the XY plane, depending on
the values supplied for X & Y values.
22. Click OK.
23. Click OK to close the Symbol Selector dialog box.
24. Click OK to close the Properties dialog box.
25. Unselect the city hall symbol and navigate around the
display to view the result.

Digitizing text graphics
Once you have added the city hall symbol to the scene, you
may find it useful to add a text annotation in the same view.
The text graphic element allows one to digitize 2D or 3D
text in the scene.
1. Click Bookmarks and click City Hall.
Zoom in to the roof of City Hall.
2. On the Globe 3D Graphics toolbar, click the Graphics
drop-down menu and click Default Element Properties.
3. Click Text button.
The Default Text Element Properties dialog box opens.
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6
3

4. Click the Text tab.

7

4

The mouse tip displays the color name in the style
palette.
7. Click OK to close the Symbol Selector dialog box.
8. Click the Effects tab on the Default Text Element
Properties dialog box.
9 Uncheck Pin to surface.

5

The Pin to surface option is useful if you want to fix the
text graphic to the underlying globe surface. In this case,
we want to digitize the text on the roof of the City Hall.

5. Click the Change Symbol button to open the Symbol
Selector dialog box.
6. Click the Color drop-down arrow and choose Solar
Yellow color from style palette.
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8

14. Type “City Hall” in the text box and press Enter.
15. Unselect the text element and navigate around the
display.

R

9

T

Q
10. Click OK to close the Default Text Element Properties
dialog box.

The text appears at the location you clicked.

11. Click OK to close the Default Element Properties
dialog box.
12. On the Globe 3D Graphics toolbar, click the New Text
tool.

E
13. Click on the roof of city hall graphic.
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Adding and modifying a 3D graphics layer

6. On the Graphics toolbar, click New Marker.

1. Click the Add Data button.

7. Click to add a marker in front of each of the first 3 cars
as shown here. You will have to click the New Marker
tool for each new marker.

2. Browse to the Exercise9\GeoDatabase folder.
3. Double-click the Street Objects layer to add it to
ArcGlobe.

You can also choose to digitize multiple graphics while
using any of the graphic tools by simply clicking Tools,
then click Options and select the General Tab. Check the
option to Keep drawing tools active after drawing
graphic.

3

4. Click Bookmarks and click Street View.
5. On the Globe 3D Graphics toolbar, click the Graphics
menu, point to Active Graphics Layer Target, then click
Street Objects.

5

87
You will now assign each marker a 3D graphic symbol
from the Street Furniture symbol style.
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8. Click the Select Graphics tool and click the first marker.
A selected marker will change color.

9. Right-click the selected marker and click Properties.

14. Click OK on the Properties dialog box.
Repeat steps 8 through 14 if you would like to
symbolize the other point markers using one of the
available 3D styles.
15. Right-click the Street Objects Layer in the Table of
Contents, and click Save As Layer File.

10. Click Change Symbol.
Click More Symbols to verify that 3D Street Furniture
is checked. If not, click 3D Street Furniture to add this
style.

Y

11. Click the Category drop-down list and click Street
Scene.
12. Click the tc1 symbol.
16. Navigate to Exercise9\GeoDatabase, select the Street
Objects layer file, and click Save.

E

Click Yes if prompted to overwrite the existing file. The
new markers you created are stored in Street Objects
layer.

U
13. Click OK on the Symbol Selector dialog box.
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Final view
You have successfully created a realistic 3D view of small
area within London. You can use one of the many
navigation tools available such as navigate, pan, and zoom
to browse the scene. You can also use the fly tool to fly over
your city model.

In this exercise, you learned how to transform 2D feature
datasets into realistic looking 3D data models. This exercise
also focused on accessing symbol libraries for styles to
match layer attributes. You can quickly personalize your
scene with several symbol property options.
Finally, the 3D graphics toolbar is a host of many tools
necessary to create and edit new 3D graphics layers and
features. You are well on your way to adding realism to
your 3D scene by using 3D graphics tools and symbology
options available within ArcGlobe.
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